
ОБЩИЕ ТРЕБОВАНИЯ К ГОТОВЫМ ОРИГИНАЛ-МАКЕТАМ, 
ПРЕДОСТАВЛЯЕМЫМ ЗАКАЗЧИКОМ 

Важное примечание: 

В этом материале мы собрали основные сведения, о технических параметрах корректного 
оригинал макета для предоставления в типографию и способах достижения этих параметров. 

Но в одном материале всё учесть невозможно, поэтому, если Вы чувствуете, что какой-то из 
Ваших вопросов остался без должного ответа, обратитесь напрямую к нашему менеджеру и он 
свяжет Вас либо с отделом препресс, либо с технологом и мы разрешим все Ваши сомнения. 

Готовые оригинал-макеты принимаются от заказчика на любых носителях: 
CD-R(W) 
DVD-R(W), DVD+R(W) 
USB  - накопители 
А также путём пересылки по сети интернет. 
Файлы до 10 мегабайт можно пересылать напрямую по электронной почте. Для файлов и 
комплектов боле 10 мегабайт используйте облачные хранилища: яндекс диск, диск мейл.ру или 
файлообменный сайт, в котором не установленные временные ограничения для скачивания. 
Например: https://transfiles.ru/ 

Названия файлов не должны повторяться, не должны содержать кириллицу. В названиях 
допускаются только латинские буквы, цифры и знаки нижнего подчёркивания и тире. 

При подготовке файлов к предоставлению (пересылке) в типографию, необходимо проверить, что 
предоставляется только один - финальный вариант каждого макета. Особенности сборки всех 
необходимых файлов для разных видов программ смотрите ниже в разделе «Некоторые 
замечания по конкретным программам» 

Для пересылки файлов через сеть интернет, рекомендуется помещать файлы и папки, в архив, 
особенно, если макетов много или много прилагаемых к макету рабочих файлов.  

Cтруктура файлов. 

Количество и порядок следования страниц в файле соответствуют количеству и порядку 
следования страниц в готовом изделии либо его отдельной детали (например, блок клеевой 
брошюры).  
Названия PDF файлов отражают то, к какой части продукции они относятся:  

• содержат название детали (обложка, блок, вклейка и т.п.), если они относятся к этим 
деталям;  

• начинаются с номера изделия в сборном заказе (нумерация изделий должна 
соответствовать техническому заданию); 

• в сборном заказе изделий с разными тиражами мы рекомендуем указывать их в имени 
файла после служебного символа «#». 

Макеты принимаются в следующих программах: 
Adobe Acrobat (PDF) Это предпочтительный для макетов формат файлов. Рекомендуется 
использовать стандарт PDF/X-1a (PDF 1.4), согласно международному стандарту ISO 15930-4:2003 
Adobe InDesign (не выше версии 2020) 
Adobe Illustrator (не выше версии 2020) 
CorelDraw (не выше версии X7) 
Adobe Photoshop (не выше версии 2020) 
 
Во всех программах верстки цветовые профили должны быть по умолчанию, а 
«ColorManagement» должен быть в положении «off». 
 
Многополосную верстку необходимо сдавать исключительно в программах: Adobe Acrobat (PDF) 
в виде многостраничного документа, или в виде многополосной вёрстки в Adobe InDesign, Corel 
Draw, Adobe Illustrator 
Отдельные файлы EPS или TIFF подходят только для макетов листовой продукции. 
  

Макетами не являются, макеты созданные в приложениях, не поддерживающие PostScript 



CMYK цветоделения и не учитывающие особенности допечатной подготовки (например: Microsoft 
Powerpoint, Microsoft Exel, Microsoft Word и т.п.).   
 

 

ОСНОВНЫЕ ТРЕБОВАНИЯ 
1) К каждому макету (группе макетов сборного задания) необходимо ТЗ (техническое задание), 
содержащее  

• обрезной формат изделия,  

• цветность 

• полосность,  

• бумага (тип, плотность),  

2) Обрезной формат документа в программе (Trim Box в PDF файле, размер artboard в Adobe 
Illustrator, размер страницы в Adobe InDesign и CorelDraw ) должен ТОЧНО соответствовать 
формату готового изделия.  
Макеты буклетов (листовых изделий с фальцовкой), обложек термоклеевых изданий и макетов 
упаковки должны соответство виду изделия (либо его детали) в полном развороте (развертке) 

3) НЕ допускается использование цветовых моделей кроме CMYK, Pantone (таких как RGB, 
HSB, LAB) 

4) У элементов макета, идущих под обрез должны быть корректные вылеты за обрез: 5 мм для 
многостраничных изданий и 2 мм для листовых.  
Элементы макета, не идущие под обрез, не должны располагаться ближе 3 мм к линии обреза. 
Все элементы макета, находящиеся в зоне 3 мм с обеих сторон от линии обреза, могут попасть в 
готовую продукцию как полностью, так и частично, либо же не попасть вовсе. 

5) В макетах, сверстанных в программах Corel Draw и Adobe Illustrator ВЕСЬ ТЕКСТ должен быть в 
кривых. 

6) Разрешение растровых CMYK и Grayscale изображений не должно быть ниже 200 ppi. 
Рекомендуемое значение – 300 ppi. Разрешение растровых однобитных изображений (Bitmap) не 
ниже 600 ppi. Рекомендуемое значение – 1200 ppi. Рекомендуемый тип сжатия растровой графики 
–  JPEG с максимальным качеством. 

 7) В верстке должны быть использованы ТОЛЬКО файлы форматов EPS и TIFF, за исключением 
Adobe InDesign, где допускается использование файлов формата PSD, AI и JPG. 
Имена завёрстываемых иллюстраций должны быть прописаны исключительно латиницей, в ином 
случае файл вёрстки после пересылки может перестать их видеть. 

8) При верстке буклетов с фальцовкой внутрь более чем с 1-м фальцем (типа «евро» или 
«улитка») учитывайте, что ширину внутренних полос нужно сделать меньше внешних на 2 мм 

9) Места УФ-лакировки или тиснения, а также контуры вырубки необходимо в вёрстке 
помечать любым плашечным (Spot color) цветом с помощью векторных объектов в отдельном 
слое с заданным атрибутом Overprint. 
При выводе PDF эти слои должны оставаться в файле наложенными на макет (НЕ в 
отдельном файле и НЕ на отдельных страницах). 

10) Верстка блока на клеевое скрепление имеет значимые особенности и необходимо их 

учесть. Подробно – в разделе «Для продукции, скрепляемой клеевым бесшвейным 

способом (КБС) дополнительно»  

Общие замечания к верстке. 

 

ВЫЛЕТЫ 
Чтобы избежать возможных ошибок, перед началом работы в программе верстки установите 

размер страницы соответствующий послеобрезному формату (при этом элементы с напуском 
будут размещаться с вылетом за пределы страницы).  

Обращайте особое внимание на то, что элементы, иллюстрации, фоновые заливки, печатаемые 
"под обрез", должны иметь "вылет" от 2 мм за линию реза для листовой продукции и от 5 мм за 



линию реза для многополосной продукции. При этом элементы оформления, текстовые блоки, не 
идущие под обрез, должны отстоять от линии реза не менее чем на 3 мм. 

Если макет предусматривает в дальнейшем вырубку со штампа – необходимо в отдельном слое 
отрисовать контур вырубки в виде векторного объекта, наложенный на основное изображение. 
Внешние размеры контура штампа должны совпадать с установленным в программе размером 
страницы. При этом вылеты должны составлять минимум 3 мм от края вырубки. 

 

ШРИФТЫ 
Весь текст в файлах TIF, EPS, AI или CDR необходимо окривить, при этом количество "узлов" в 
блоке не должно превышать 1200.  
Если же Вы сдаете верстку в InDesign необходимо прикладывать к ней все используемые шрифты. 
По возможности используйте шрифты Open Tipe. Если Вы используете шрифты TrueType и 
Type I, убедитесь в том, что имена шрифтов TrueType, Type I и Open Tipe не совпадают, иначе 
можно получить непредсказуемый результат.  
Ни в коем случае не используйте системные шрифты!  Используйте ТОЛЬКО проверенные 
шрифты. 
При размещении текста рядом с иллюстрацией, имеющей обтравочный контур или прозрачности, 
убедитесь, что текст идёт ПОВЕРХ иллюстрации, а не под прозрачной её частью, иначе при 
выводе на печать часть чёрной надписи, совмещённая с картинкой, может стать четырёх цветной 
и отличаться по цвету и плотности от соседних частей в напечатанном изделии. Исправить, это 
будет нельзя, так как эта часть надписи будет отрастрирована). 

ЦВЕТА  

Все цвета, которые Вы используете в публикации, необходимо перевести в CMYK (CMYK 
Process).  
Ни в коем случае не оставляйте элементы верстки окрашенными цветами системы RGB. 
Если какой либо цвет должен быть отпечатан дополнительным прогоном, он должен быть явно 
задан как Spot Color. Определяя триадные (Process) и плашечные (Spot) цвета, используйте 
каталоги образцовых оттисков PANTONE. Даже самые дорогие мониторы не в состоянии точно 
воспроизвести тиражный цвет.  
Если Вы задаёте собственный плашечный цвет, не используйте в его названии кириллицы – это 
чревато тем, что професиональные программы могут не увидеть этот цвет или определить его 
непредсказуемо. 
При верстке с металлизированными пантонами (серебро, бронза, золото: 871 – 877): любым 
объектам с цветом 100% Black, лежащим поверх объектов, покрашенных в любой из 
металлизированных пантонов должен быть задан цвет 99% Black с целью предотвращения 
автоматического задания им атрибута Overprint (если этого не сделать - при печати макета 
металлизированный пантон, если он печатается последним, закроет черный объект, либо же 
чёрный будет напечатан поверх пантона и будет отличаться от чёрного напечатанного рядом по 
бумаге). 
Нужно весьма аккуратно работать с атрибутом «overprint». Особенно с белыми элементами.  
Все белые элементы, которым задан «overprint», на печати просто исчезнут. В векторной 
графике по умолчанию все 100% черные элементы (тексты, линии и тд) печатаются с атрибутом 
"overprint". 

СУММАРНАЯ ПЛОТНОСТЬ КРАСОК 
Существует огромное количество видов бумаги, и каждая имеет свои физические свойства, одно из 
которых – адгезия (свойство впитывать краску). Чем тоньше бумага и больше краски, тем дольше 
будет сохнуть отпечатанный экземпляр. А в случае, когда количество краски доходит до 
определенного предела (когда бумага уже не способна впитать всю  краску, которая попала на нее) 
возможны даже физические деформации бумаги. Также вероятен отмар, то есть перенос части 
краски на соседний лист в стопе при их соприкосновении. 
Поэтому сумма красок в макете зависит от того на какой бумаге предполагается печатать изделие. 
 

• для немелованной бумаги и невпитывающие материалы - не более 280% 

• для мелованной матовой бумаги - не более 280% 

• для мелованная глянцевой весом до 90 г/м2 - не более 280% 

• для мелованная глянцевой весом более 90 г/м2 - не более 300% 

• Для получения глубокого черного цвета на крупных плашках рекомендуется использовать все 
триадные краски Для отличного результата подойдёт следующее сочетание: 
C=57% M=44%, Y=44%, K=100% 

Процент растровой точки по каждому цвету не должен быть меньше 5%. В противном случае на 
печатные формы этот цвет может не вывестись или вывестись частично. 
 

ИЗОБРАЖЕНИЯ 

Все элементы оформления и иллюстрации, помещенные в публикацию, должны быть сохранены в 



форматах TIFF или EPS. При этом нежелательно использование файлов с LZW сжатием. Не 
принимаются иллюстрации, сохраненных в других форматах (например: JPG, BMP, GIF и т.п.). 
Недопустимо использование объектов, помещенных в публикацию с использованием OLE и DDE. 
При подготовке растровых изображений к вёрстке, переводите их в CMYK и задавайте необходимый 
в вёрстке размер в программе обработки растровой графики (например Adobe Photoshop). 
Избегайте масштабирования иллюстраций непосредственно в программе вёрстки. 
Проверяйте разрешение всех используемых иллюстраций. Оно не должно быть ниже 200 ppi. 
рекомендуется  300 ppi. Разрешение штриховых изображений должно находиться в пределах от 600 
до 1200 dpi. 
При подготовке полноцветных иллюстраций отслеживайте суммарную плотность красок 
(C+M+Y+K).  
Если вы используете градиентные заливки, готовьте их в программе Adobe Photoshop. Добавляйте 
к градиенту шум (Filter > Noise) для сглаживания возможных градаций тона. 
 
Требования к векторным изображениям 

• Векторные иллюстрации должны быть записаны в формате EPS и Cdr для CorelDraw. 

• Все цвета, за исключением дополнительных прогонов, должны быть в модели CMYK. 

• Шрифты, использующиеся в этих иллюстрациях, должны быть переведены в кривые. 

• Если при подготовке файлов используются специальные эффекты такие как прозрачность, тени 
и т.д., то эти объекты необходимо отрастрировать. 

• Все растровые изображения должны быть внедрены в публикацию, иметь масштаб 100%, и 
разрешение 300 dpi. 

 

 
ТОЛЩИНА ЛИНИЙ, СОВМЕЩЕНИЕ ОБЪЕКТОВ 

Разрабатывая дизайн страницы, учитывайте возможное несовмещение красок при печати.  
Линии тоньше 0,3 мм (1 пункт) должны быть в одну краску, аналогично, выворотка тоньше 0,3 мм 

должна ложиться на одну краску.  
Минимально допустимая толщина линии от одного цвета составляет 0,2 пункта.  

НЕ ДОПУСКАТЬ использования HAIRLINE – при выводе файлов на печатные формы линия либо 
пропадет совсем, либо будет слишком тонкой и прерывистой. 
Черный текст меньше 12 пунктов должен ложиться поверх фона без выворотки (overprint).  

В программах верстки старайтесь не задавать размещение объектов и и их размеры «на глазок». 
Устанавливайте точные размеры и координаты. 100 мм и 99,927 мм на первый взгляд, 
различаются незначительно, но если это координаты соприкасающихся плашек, то в тираже вы 
получите между ними белую линию. 
 

ЭЛЕМЕНТЫ МАКЕТА ДЛЯ ПОСТПЕЧАТНЫЙ ПРОЦЕССОВ 
Элементы лака, тиснения, конгрева, контуры вырубного штампа и т.п. необходимо в вёрстке 

помечать любым плашечным (Spot color) цветом с помощью векторных объектов, которые 
должны быть покрашены в отдельный плашечный цвет (одинаковый для заливки и контура, 
если он присутствует) с названием, соответствующим постпечатному процесу и элементу 
должен быть задан аттрибут Overprint. Проверьте, что overprint задан и заливке и контуру, если он 
есть.  

Конечно же контуры вырубного штампа не должны иметь никаких заливок. 
Все элементы файла для постпечатных процесов,должны быть в одном файле с макетом, на 

своём месте в изделии, поверх остальных элементов (в верхнем слое).Для каждого вида покрытия 
или штампа нужно в вёрстке задать свой слой с соответствующим названием. 

При предоставлении макета в формате PDF элементы выборочного лакирования, 
конгревного тиснения, тиснения фольгой и т.п. необходимо выводить в общий файл.  
За счёт их окраски в плашечные цвета и аттрибута «overprint», эти цвета будут легко отключены 
при выводе на печать готового спуска полос (без ущерба для печатных элементов) и с этого же 
спуска можно будет взять готовый необходимый слой для постпечатных процессов, который не 
нужно будет отдельно собирать и посадку которого не нужно будет специально проверять. 

Плашечные цвета элементов лака, тиснения, конгрева не должны совпадать друг с другом и с 
другими сепарациями, присутствующими в файле. 

При создании слоёв лака, скрэтч слоя, нужно учесть довольно большую погрешность при печати 
этого слоя на готовый офсетный оттиск. Поэтому задайте этим элементом обводку толщиной 0,3 – 
0,5  присвойте тот же окрас и аттрибут overprint.  

 

Для продукции, скрепляемой клеевым бесшвейным способом 
(КБС) дополнительно: 

• При дизайне и верстке разворотных полос необходимо учесть влияние корешка на 

текст и изображения, проходящие через разворот.  

нежелательно использование тонких линий совмещаемых в развороте 



нежелательно использование совмещаемых в развороте значимых или мелких объектов и 
портретов.  
Не допустимо перетекания в развороте текста. Особенно мелкого. Корректно совместить 
его в КБС невозможно. 
нежелательно использование распашных объектов расположенных с наклоном. 
Если же разворотные иллюстрации и элементы всё-таки используются в брошюре на КБС, 

роспуск илюстраций должен составлять не менее 3 + 3 мм. 

 
Роспуск полос не нужен, если для КБС используется PUR клей, так как раскрываемость 
корешка у него выше. 

• необходимо учесть то, что боковая проклейка корешка уменьшает полезную площадь 
внутренних полос обложки, первой и последней страницы блока примерно на 6 мм со 
стороны корешка. Из-за этого трудно совместит изображение , переходящее со 2-й страницы 
обложки на 1-ю страницу блока, и с последней страницы блока на 3-ю страницу обложки. 
Поэтому рекомендуется избегать перетекание сложных и значимых изображений 
(портретов, мелких деталей) и текста с обложки на блок. 

 



 
 

• корешок 2 и 3 полос обложки, корешки первой и последней полос блока должны иметь белое 
поле шириной 3 мм (это делается для надежного вклеивания блока в обложку). 

• Файлы обложек должны предоставляться в виде разворотов, учитывающих размер и дизайн 
корешка Толщину корешка для конкретного количества тетрадей и типа бумаги необходимо 
дополнительно уточнить в типографии. 

 

Для продукции, скрепляемой на скобу 
У изданий, предполагающих скрепление скобой, размер полос внутренних разворотов будет 
несколько меньший, чем у внешних. Это естественный эффект, обусловленный вложением 
разворотов один в другой. Внутренние развороты как бы выдавливаются наружу. 
Соответственно, элементы, находящиеся близко к краю на внутренних полосах (колонцифры, 
рамки, плашки, располагаемые с краю и одинаковые для всех страниц ), приближаются к линии 
реза и к определённых случаях могут сместится слишком близко или вовсе зарезаться.Величина 
эффекта зависит от толщины бумаги и количества полос издания.  

 
Этот эффект может быть скомпенсирован типографией путём задачи уменьшения внутренних 
страниц и смещения всей полосы в корешок. Но если в о внутренных разворотах присутствуют 
иллюстрации, перетекающие с полосы на полосу, эту компенсацию задать будет нельзя – она 
«выест» иллюстрацию на сгибе. 
Эту особенность нужно принимать во внимание при разработке дизайна изделия и при его 
вёрстке. Например, поместить колонцифры не в край, а на середину полосы и т.п. 
 

Требования к цветопробе 
Цветопробой является оттиск, изготовленный на специализированном оборудовании, калиброванном в 
соответствии с печатным процессом. 
Необходимо проверить, чтобы в файл, предоставляемый для вывода цветопробы, не был встроен цветовой 
профиль. Привыводе цветопробы профиль будет проигнорирован и цвет изменится. 
В типографию должны представляться окончательные (утвержденные) цветопробы в формате 1:1. 



На цветопробном оттиске обязательно присутствие контрольных шкал. 
Распечатки с обычног принтера или цифровой машины цветопробой не являются. 
При внесении исправлений в файлы после изготовления цветопробных оттисков (корректировка цвета каких-
либо элементов), данный оттиск цветопробой служить не может! 
При сравнении печатных оттисков с цветопробой всегда нужно учитывать следующие факторы: 

• не все оттенки цифровой пробы идентичны печатным оттискам; 

• оттенки цвета на аналоговой цветопробе всегда насыщеннее, чем на печатных оттисках; 

• цветопроба не учитывает влияние бумаги на печатный оттиск 

• цветопроба не может абсолютно точно моделировать печатный процесс. 

 

НЕКОТОРЫЕ ЗАМЕЧАНИЯ ПО КОНКРЕТНЫМ ПРОГРАММАМ. 

PDF (Adobe Acrobat) 
• Формат файла PDF должен быть не выше версии 1.4  

• Файл должен быть композитный.  

• Необходимо наличие обрезных меток. Вылеты симметричные с четырёх сторон. 

• Полосы (или спуск) должны располагаться строго по центру полосы PDF-файла. 

• Разрешение всех изображений должно быть пригодным для офсетной печати (300 dpi), все 
используемые шрифты должны быть встроены.  

• При записи PDF рекомендуется сжатие изображений методом JPG Maximum.  

• PDF очень желательно записывать только из PostScript файла с помощью программы 
Acrobat Distiller с  настройками «PDF/X-1a» или «Press Quality» (PDF 1.4).  

• Правка и дальнейшее сохранение полученного PDF в программе Acrobat или в любой 
другой программе не допускается. 

• Подробную информацию о формате PDF и о том, как корректно перевести свою вёрстку 
в пригодный для полиграфии PDF-файл, см. в материале «Что такое PDF и как его 
сделать?». 

 
Adobe InDesign 
К верстке должны быть приложены все используемые шрифты и вся импортированная графика. 
Элементы верстки, помещенные как OLE-объекты или посредством метода «copy-paste» из других 
приложений НЕ ДОПУСКАЕТСЯ (за исключением текста, помещенного в текстовые блоки и 
векторных объектов Adobe Illustrator). Сборка для передачи в типографию осуществляется с 
помощью File -> Package.  
Некоторые шрифты (русские) в подборку автоматически могут не войти, их следует проверить. Все 
прилинкованные изображения должны иметь статус OK (не Missing и не Modified). 
Очень желательно дополнять сборку файлом «*.idml», (File > Save as или File > Export  для 
версии Adobe InDesign CS5 и ниже), для возможности открыть в предыдущих версиях Adobe 
InDesign. Файл «*.idml», необходимо сохранить из финальной версии вёрстки непосредственно 
перед отсылкой сборки в типографию. 
 
Adobe Illustrator. 
Окончив работу над файлом, переведите текст в кривые (оставьте для себя версию файла НЕ в 
кривых, для возможных правок). Переведите элементы изображения на один слой и сохраните 
отработанный файл в формате EPS  для дальнейшего размещения его в публикации. Элементы 
с эффектами прозрачности, наложения (Multiply, Overlay, Transparency, Drop Shadow, Glow и 
пр.) должны быть растрированы. Убедитесь, что все триадные цвета заданы явно как CMYK 
Process, а все плашечные цвета, требующие отдельного цветопрогона и соответственно 
отдельной пленки - как Spot Color. Остальные цвета удалите из публикации.  
КАЖДАЯ ПОЛОСА МАКЕТА ДОЛЖНА БЫТЬ СВЁРСТАНА НА ОТДЕЛЬНОЙ СТРАНИЦЕ (artboard), 
например: несколько визиток не должны быть разбросаны просто по полю файла, а помещены 
каждая на свой artboard («монтажная область» в руссифицированных версиях Adobe Illustrator) 
лицо и оборот буклета – также на отдельных artboard с соседними номерами и т.п. 
 
Adobe Photoshop. 
Сохраняя изображение для размещения в публикации, используйте форматы TIFF или EPS.  
Файл должен соответствовать цветовой модели CMYK.  
Убедитесь, что файл не содержит в себе каких либо дополнительных каналов, слоев и путей, за 
исключением пути обтравки (Clipping Path). 
Без необходимости применения сложных эффектов к тексту, не набирайте его в пакетах растровой 
графики. Если текст все-таки набран: не меняйте параметров Image Size, будьте готовы к тому, что 
напечатанный текст (особенно мелкий) может оказаться размытым, неразборчивым, с "рваными" 
краями.  
Убедитесь в том, что разрешение изображения составляет не менее 300 точек на дюйм и размер 
изображения соответствует размеру, который иллюстрация должна иметь в файле вёрстки. 
 



CorelDRAW.  
Лицевая и оборотная стороны документов должны находиться в одном файле на 
последовательных страницах. 
Пожалуйста, верстайте в ОБРЕЗНОМ ФОРМАТЕ. Для этого передначалом вёрстки выставьте 
размер страниц равным формату готового изделия. Всё, что обрезается, должно располагаться за 
краем страницы 
Работайте в цветовом пространстве CMYK. 
Если в макете используются растровые изображения, в CMYK они должны быть переведены 
заранее. 
По окончании работы над макетом все шрифты перевести в кривые. 
Если Вы предполагаете делать в макете различные эффекты к объектам, эти объекты лучше 
готовить в Adobe Photoshop. 
 


